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Preface

Thank you for purchasing this product. This user guide provides hardware specifications and other
information about the PCI-M324 motion control card.
This user guide includes:
B Product Overview
Installation
Signal Connection Interface
Terminal Board
Wiring
EzDMC Functions

Product features of the PCI-M324 motion control card
PCI-M324 is a motion control card with DSP (Digital Signal Processor) as the core design,
and the controlling method between the servo drive is with the use of pulse output. Through the
high-performance chip to calculate the motion trajectory, it provides synchronous timing control for
multiple axes and DI/O processing functions. With the general motion software library and
diagnostic tool for the graphic interface, program development becomes easier, which also

simplifies the system construction and troubleshooting for users.

How to use this user guide
You can refer to the information in this user guide when using the PCI-M324 motion control card.

This user guide provides the hardware electrical specifications and wiring examples of the
PCI-M324 card. Prior to connecting to external devices, please read this user guide to understand

the features of each I/O pin of the PCI-M324 card and the hardware configuration.

Delta technical services:
Please consult your Delta equipment distributor or Delta Customer Service Center if you encounter

any problems.
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PCI-M324 is a 4-axis pulse type motion control card for 4-axis servo or stepping motion
control. This chapter includes the function descriptions, specifications, safety
instructions, and other information of the PCI-M324 motion control card to help you

quickly understand the product features.
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1.1 Function description

PCI-M324 is a 4-axis motion control card using a standard PCI interface. It generates
high-frequency control pulses (3.2 MHz) to control the stepper motor or servo motor. With the
4-axis motion control function, it provides 2-axis circular interpolation motion control, 4-axis linear
interpolation, or continuous interpolation motion control at constant speed. Multiple PCI-M324
motion control cards can operate simultaneously in one system and perform motion control
functions. To allow users to quickly learn to operate the control card, Delta developed software
auxiliary tools to help you complete the application development and wiring test work in the

shortest possible time.

The four main axis controls of the PCI-M324 motion control card are built-in with the incremental
encoder interface, which can correct the incorrect mechanical data transmission. PCI-M324 is
equipped with precise and fast-motion position comparison and triggering functions, and does
not take up additional CPU resources. In addition, the interfaces for the contacts, servo motor
drive control, and general I/O signal control have a very intuitive design for wiring, so that
beginners can quickly get hold of the motion control basics and reduce product losses for system
integrators due to wiring errors. The motion control function includes acceleration / deceleration
of linear motion and S-curve control, arbitrary 2-axis circular interpolation, 2- / 3-axis linear
interpolation, continuous motion, 35 homing modes, etc. When executing these complex motion
control functions, your CPU computing resources can deal with other applications without being

occupied by the motion control functions.
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1.2 Specifications

B Product features

(1) Maximum 3.2 MHz, 4-axis pulse output

(2) Linear, circular, and continuous interpolations

(3) Programmable acceleration / deceleration time

(4) Programmable pulse output and interrupt functions

(5) Position comparison and signal trigger

B Motion control specifications

(1) Pulse output control: OUT/ DIR, CW / CCW, AB Phase

(2) Pulse output rate: maximum 3.2 Mpps

(3) Total number of pulse signals: 32 bits (+2,147,483,648 pulses)
(4) Homing modes: 35 types

(5) Speed curve control: T-curve and S-curve

(6) Interpolation modes: linear, circular, and continuous

(7) Total number of counter signals: 32-bit up / down counter x 4

(8) Position latch input: LTC x 4

(9) Position compare output: CMP x 2

(10) Incremental encoder input: tEAX 4, tEB x 4

(11) Encoder Z-phase signal input: tEZ x 4

(12) Mechanical Dl interface: PEL x 4, MEL x 4, ORG x 4, SLD x 4
(13) Servo drive interface: ALM x 4, RDY x 4, SVON x 4, INP x 4, ERC x 4
(14) General input point: IN x 4

(15) General output point: OUT x 4

(16) 1/O pin type: optically isolated with 2.5 KVrys on all 100-pin SCSI

B General electrical specifications

(1) PCI specification: 2.2; 32-bit support, 3.3 /5 Vpc operation type
(2) Power consumption: typical +5 Vpc at 0.5A
(3) Operating temperature: 0°C - 50°C (32°F - 122°F)
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1-4

1.3 Safety precautions

To avoid electric shock resulting in serious damage, please check the following precautions

before installing the equipment:

(1) Before moving the host computer, please unplug the computer power cord from the
power outlet.

(2) When adding hardware to the system, please connect the device's signal cable before
connecting the power cord; when removing hardware from the system, please disconnect
the device's signal cable before disconnecting the power cord. If possible, turn off the
computer's power supply before installing the hardware.

(3) Before connecting or disconnecting any signal cables from the motherboard, please make
sure all power cables are unplugged.

(4) Before using the interface card or expansion card, it is recommended that you first seek
professional assistance, as these devices may interfere with the grounded circuits.

(5) Please make sure the voltage power supply unit is adjusted to the standard level used in
the country / region where the machine is installed. If you are unsure of the supplying
voltage of the given area, please contact the local power company for more information.

(6) If the power supply unit is damaged, do not repair it by yourself. Please contact technicians

or distributors for assistance.

1.4 Operational safety instructions

Before you install a hardware device, please review the information provided in this user guide.

(1) Before using the product, make sure all cables and power cords are properly connected.
If you find any major defects, please contact your distributor as soon as possible.

(2) To avoid short circuit, please put away all unused screws, paper clips, and other parts.
Please do not leave them on the motherboard or the host computer.

(3) Dust, humidity, and severe temperature changes can affect the product lifespan.
Thus, avoid placing the product in places with these conditions.

(4) Do not place the host computer on an unstable surface.

(5) If you have any technical questions regarding the use of this product, please contact a

certified technician for assistance.

November, 2017



PCI-M324 User Guide Product Overview

1.5 Supported software

B Programming Library

You can develop relevant applications on the Windows XP / 7 platform. By categorizing the
motion control related API into usage condition and application, and with the programming guide,

you can quickly develop relevant applications.

B EzDMC

EzDMC is an auxiliary software that can be operated on Windows XP / 7. Prior to developing the
application, you can use the auxiliary program to check and set the hardware contact logic status
to make sure that the external wiring is correct. You can also use this program to control the
wired servo drive and motor to assist in the adjustment and testing of the machine. In the initial
stage of using PCI-M324 for program development, you can also use EzDMC to simplify the
parameter setting and functional test verification, which can help new users to reduce the time

required for learning and development.
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1.6 Application development

B Software application development structure

wnm]
=
O O)
(=1
=)

[ Window XP /7

HM1 / Programming
BCB++/VB/
VC++/C#

EzDMC

[ Motion API

SCSI 100 Pins
Cable

[ Master station

[ PCI-M324

[ ] Flow chart

Motor #1

[
[ vowrr2 |
[
[

Motor #3

Motor #4

The following is a flow chart for the application development process to help you understand

how to use this user guide for the connection and reference of the program development.

The connection between chapters and the sequence, as well as the development of the

application, can be seen in the flow chart.
Start
v

1. Install hardware

2. Select and set jumper
wire
3. Connect all wiring

v

Activate EzDMC:
set system parameter

!

Activate EzDMC:
verify system parameter
setting

'

Use the control card
function library to
develop the application

Is the system
yorking properly 2

Y

1-6

Refer to Chapters 2, 3,
4, and 5 for details

Refer to Chapter 6
for details

Refer to Chapter 6
for details

Refer to PCI-M324
Function Library
Programming
Guide for details
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This chapter describes how to install the PCI-M324 motion control card. Please follow

the installation procedure below.

2.1 Product packaging and aCCESSOMES «+««««+t+s srrrrrerriumrrtaaiiiiiiaaniiieene 2.2
2.2 PCB diagram .................................................................................... 2-3
2.3 HAIOWAIE INStAIALION - -+« -+« +eeveeeeneenennenaenaenanenaenaeeeaaaenaeneaeaaenaenaneeees 2.4
2.3.1 Hardware SELNG ..........uuuuuummiiiiiiiiiiiii s 2-4
2.3.2  PCI SIOt SEIECHON ...ttt s 2-4
2.3.3 INStallation ProCEAUIE .........uuiiiiiiiiiiiii s 2-4
2.3.4 TroubleSNOOtING ......uuuiiiiiiiiiii 2-4
2.4 DIIVEr SOFWAIE INSTAIIALION -+« rverrerrerrnrenmmnenrenmmnenneenrnrenaeeaneenenarneenennees 2.5
2.5 CONNECLOr PiN AESCHIPHON -+ +++xxrrreesssrrrreasasitietea sttt e 2.6
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2.5.2 CN3: position comparison triggering signal port..........cccoeeeevvveeiiiiinieennnnns 2-9
2.5.3 RSW1: switch for card ID number setting .........ccoovvvviiiniiiiiiiiiiciiee e, 2-10
2.5.4 JP1: select jumper according to input signal type (NPN / PNP).............. 2-11

2.5.5 JP2:internal pulse (DDA) 5V ground and external +24V ground

£y 10 [ T= L1000 1= SN 2-12
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2.1 Product packaging and accessories

The package should contain the following items:

Standard

B Advanced 4-axis servo or stepping PCI-M324 motion control card x 1
B PCI-M324 driver CD-ROM x 1
B PCI-M324 User Guide x 1

Optional

[ | Motion control terminal block

B SCSI 100-pin signal connector cable

If there are missing or damaged standard parts, please contact the distributor for the

replacement parts. Please keep the packaging material in case of future shipping needs.
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2.2 PCB diagram

This is the general structure of the PCI-M324 motion control card displaying the positions for
CN1, JP1, JP2, CN3, and RSW1.

CN3

Description of each connector on the PCI-M324 card is as follows:

Name Function
CN1 SCSI 100 pins, 4-axis motion control /O signal port
CN3 Position comparison triggering signal port
JP1 Select jumper according to input signal type (NPN / PNP)
JP2 Pulse output I/O and external +24V ground signal jumper
RSW1 Card ID switch
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2.3 Hardware installation
2.3.1 Hardware setting

The PCI-M324 is a standard Plug and Play expansion device for PCs. Whether the use of
memory space configuration or 1/0O port configuration, or other basic system required functions,

these are configured by the BIOS of the PC system. You do not need to set the hardware.

2.3.2 PCl slot selection

When your PC system is built-in with ISA and PCI expansion slots, please do not insert the
PCI-M324 card into the ISA expansion slot. In addition to the shape not matching, this product is
designed for PCI compatible devices, thus it can only function when inserted into a standard PCI

expansion slot.

2.3.3 Installation procedure

Please read this user guide carefully and adjust the functions of RSW1, JP1, and JP2 according

to the requirements before installation to meet your system development needs.

(1) Turn off the power. Make sure that the PC power supply is completely disconnected and turn
off the power for the connected devices, such as the printer, modem, and screen.

(2) Remove the cover of your PC. Install the PCI-M324 card only in the standard PCI expansion
slot. Please do not install it in the ISA or EISA expansion slot.

(3) Before you take out the card from the packaging, please neutralize the static electricity that
might be on your body to avoid damaging the product.

(4) Insert the PCI-M324 card into the appropriate PCI standard expansion slot, then tighten the
screws to fix the card onto the PC expansion slot.

(5) Make sure to disconnect the power supply before removing the PCI-M324 card.

2.3.4 Troubleshooting

If the system cannot start properly, please turn off the system first and disconnect the power.
Remove the cover of your PC. Next, make sure the PCI-M324 card is properly installed, such as
if the screws are loose or if the card is detached from the PCI expansion slot. Remove the
PCI-M324 card from the PCI slot and restart the PC to check that the PC system is working
properly. If the PC system is working properly, please reinstall the PCI-M324 card by following
the installation procedure in Section 2.3.3. If the system still cannot start properly, please contact

your distributor for assistance.
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2.4 Driver software installation

Please note the following before installing the driver and application software:

(1) The driver for this product is currently only compatible with Windows XP / 7. Before installing
this product, please make sure that the operating system meets the requirement of this
product.

(2) Insert the Autorun driver CD-ROM into your CD-ROM drive and let the system automatically
run the setup program.

(3) When the setup program is launched, please follow the instructions for installing the
product-related driver and auxiliary application.

(4) After the product-related driver and auxiliary application are installed, restart the operating
system to ensure that the driver is installed. Please also make sure that the auxiliary

application works properly after you restart the operating system.
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2.5 Connector pin description

This section provides detailed specifications and functions of the PCI-M324 motion control card

I/0O signal terminals.

O
=
100| ~|50 -
L T
= %/_
51 (|1 ——_— ;
o) (1) (2) B

(1) CN1 connector (male); (2) CN1 I/O signal connector (female)

2.5.1 CNL1: /O signal port

Pin Mark I/O Description ’ Pin ’ Mark 1/0 Description
1 24V Power +24V / 200 mA 51 24V Power +24V / 200 mA
2 EGND 24V ground signal 52 EGND 24V ground signal
3 EMG | | Emergency stop signal 53 EMG | | Emergency stop signal
st . . rd . .
4 MEL_1 | 1 rnephamcal negative 54 MEL_3 | 3 _me_chanlcal negative
limit signal limit signal
st . i rd : e
5 PEL 1 | 1 rnephamcal positive 55 PEL 3 | 3 _me_chanlcal positive
limit signal limit signal
6 ORG_1 | 1% origin position signal 56 ORG_3 I | 3" origin position signal
st . . rd . .
7 SLD 1 | 1. deceleration point 57 SLD 3 | 3_ deceleration point
signal signal
nd . . th . .
8 MEL_2 | 2 .mt.echanlcal negative 58 MEL 4 | 4 _me_chanlcal negative
limit signal limit signal
nd : P th . .
9 PEL 2 | 2 .m.echanlcal positive 59 PEL 4 | 4 .mgchanlcal positive
limit signal limit signal
10 ORG_2 | | 2" origin position signal 60 ORG_4 | | 4™ origin position signal
nd : : th . .
1 SLD 2 | 2. deceleration point 61 SLD 4 | 4' deceleration point
signal signal
12 RDY_1 I | 1% servo ready 62 RDY_3 | | 3 servo ready
13 INP_1 I | 1% servo in place signal 63 INP_3 I | 3 servoin place signal
14 ALM_1 | | 1% servo alarm 64 | ALM 3 I |3 servoalarm
15 DI_1 | | 1% axis GPIO input 65 DI_3 I | 3 axis GPIO input
16 = RDY_ 2 | | 2" servo ready 66 | RDY_ 4 I | 4™ servo ready
17 INP_2 | | 2" servo in place signal 67 INP_4 I | 4™ servoin place signal
18 = ALM 2 | | 2" servo alarm 68 | ALM_ 4 I | 4™ servo alarm
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Pin Mark I/O Description ‘ Pin ‘ Mark I/0 Description
19 DI_2 I 2" axis GPIO input 69 DI_4 I 4™ axis GPIO input
20 EGND 24V ground signal 70 EGND 24V ground signal
21 | SVON_1 | O |1%servoon 71 | SVON.3 | O |3“servoon
2 | Erc1 | o 1% clear servo error 72| Erc3 | o 3 clear servo error

- counter - counter

1 larm cleari 30 larm cleari

23 | ALMC 1 O servo alarm clearing 73 ALMC 3 | O servo alarm clearing

- output - output
24 DO_1 O | 1% axis GPIO output 74 DO_3 0 | 3“axis GPIO output
25 | SVON.2 | O 2" servoon 75 | SVON.4 O |4™servoon
26 ERC2 | O 2" clear servo error 76 ERC 4 O 4" clear servo error

- counter - counter
27 ALMC 2 | O 2" servo alarm clearing 77 | ALMC 4 0 4" servo alarm clearing

- output - output
28 DO_2 O | 2" axis GPIO output 78 DO_4 O | 4™ axis GPIO output
50 Ea+ 1 || L Aphaseencoder 70 | EA+ 3 || 3“Aphase encoder

- signal (+) - signal (+)
30 | EA 1 | | 1* Aphase encoder 80 | EA 3 || 3“Aphase encoder

- signal (-) - signal (-)
31 gp+1 || L'Bphaseencoder a1 Ems 3 | | 3Bphaseencoder

- signal (+) - signal (+)
32 EB- 1 | 1% B phase encoder a2 | EB 3 | 3" B phase encoder

- signal (-) - signal (-)
33 EZ+ 1 | 1% Z phase encoder a3 | Ez+ 3 | 3"Z phase encoder

- signal (+) - signal (+)
34 Ez- 1 | 1 Z phase encoder 84 E7. 3 | 3" 7 phase encoder

- signal (-) - signal (-)
35 EA+ 2 | 2"! A phase encoder 85 | EA+ 4 | 4™ A phase encoder

- signal (+) - signal (+)
36 EA- 2 | 2" A phase encoder 86 EA- 4 | 4™ A phase encoder

- signal (-) - signal (-)
37 | EB+ 2 | 2" B phase encoder 87 | EB+ 4 | 4" B phase encoder

- signal (+) - signal (+)
38 EB- 2 | 2™ B phase encoder 88 | EB- 4 | 4" B phase encoder

- signal (-) - signal (-)
39 EzZ+ 2 | 2™Z phase encoder g0 | Ez+ 4 | 4" Z phase encoder

- signal (+) - signal (+)
40 E7Z- 2 | 2" 7 phase encoder 90 £z 4 | 4" 7 phase encoder

- signal (-) - signal (-)

DDA 5V voltage output, DDA 5V voltage output,

41 DDA 5V | <100 mA 91 DDA 5V | <100 MA
42 IGND DDA 5V ground signal 92 IGND DDA 5V ground signal
43 | DR+1 O 1% direction pulse o3 | DIR+ 3 | © 3" direction pulse

- signal (+) - signal (+)
4 | DR 1 o L diection pulse o2 | DIR-3 | © 3" direction pulse

- signal (-) - signal (-)
45 | OUT+1 | O | 1%outputpulsesignal (+) | 95 OUT+ 3 | O | 3output pulse signal (+)
46 | OUT-1 | O 1%outputpulsesignal(-) | 96 | OUT-_3 O | 3“output pulse signal (-)
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Pin Mark I/O Description ‘ Pin ‘ Mark I/0 Description
nd . . th - .
47 DIR+ 2 o 2. direction pulse 97 DIR+ 4 o 4. direction pulse
- signal (+) - signal (+)
nd . . th - .
48 DIR- 2 o 2. direction pulse 98 DIR- 4 o 4_ direction pulse
- signal (-) - signal (-)
49 OuUT+_2 o 2™ output pulse signal (+) | 99 OUT+_4 o 4" output pulse signal (+)
50 OUT-_2 o 2™ output pulse signal (-) | 100 | OUT-_4 o 4" output pulse signal (-)
Note:
1. GPIO is short for General Purpose Input / Output.

2.

2-8

5V voltage output.

Pin 41, Pin 91: DDA 5V voltage output, | < 100 mA. Only for checking the 5V signal detection, not recommended as
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2.5.2 CNS3: position comparison triggering signal port

This section provides detailed specifications and functions of the PCI-M324 CN3.
1 1

) : :

P

(2)
(1) CN3 connector (male); (2) CN3 connector (female)
The following table shows the CN3 pin definition:
Pin Mark Description

1 3.3V CMP_OUT CMOS 3.3V triggering signal outputs when position reached

2 DGND CMOS 3.3V ground signal

3 DGND CMOS 3.3V ground signal

4 1.65(V) Vref 1.65V LVDS reference voltage

November, 2017 2-9
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2.5.3 RSW1: switch for card ID number setting

This is the RSW1 switch knob. Card ID is the value corresponding to the position the knob is

assigned to. The setting value range is O - 15.

2-10 November, 2017
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2.5.4 JP1: select jumper according to input signal type (NPN / PNP)

This section introduces the PCI-M324 motion control card using the short-circuit latch for NPN /
PNP switching.

- (] (]
(1)
@\\ : H : i
i (2)
or
%1 1 2 3
NPN PNP
The following table shows the JP1 pin definition:
Pin Mark Description
1 124V Internal +24V voltage contact
2 ICOM Input signal internal common contact
3 EGND 24V ground signal
Note:

1. NPN mode: Pin 1 & Pin 2 short circuit. (Default)

2. PNP mode: Pin 2 & Pin 3 short circuit.
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2.5.5 JP2: internal pulse (DDA) 5V ground and external +24V ground
signal jumper

This section introduces the PCI-M324 motion control card using the short-circuit latch for

common or individual grounding for the 5V ground and external ground signal.

i [~ I
(1)
= P P
= _ (2)
\
W 123 123
B i GND OPEN GND CLOSE
The following table shows the JP2 pin definition:
Pin Mark Description
1 Not in use Reserved (not in use)
2 IGND DDA pulse ground signal
3 EGND 24V ground signal
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This chapter introduces the PCI-M324 signal connection interface.

3.1 OPeration INTEIFACE «««+-rrwrrrrrrrrerner et 3-2
3.1.1 Mechanical DI/O INtEIFACE ..........uuummiiii s 3-2
3.1.2 Servo drive DI/O INEIfACE .........uuuumiii s 3-9
3.1.3 Servo drive pulse /O INtErface ...........ccoooimii s 3-15
3.1.4 Position comparison triggering signal output interface..............cccceeeeennn. 3-18
3.1.5 Position latch signal input iNterface..........ccoooooiiiiiiiiii 3-21
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3.1 Operation interface
3.1.1 Mechanical DI/O interface

B Mechanical limit signal PEL & MEL (axis control signal / DI signal)

Endpoint setting function: in general, when executing motion control, users will set two limit
sensors between a fixed distance. Setting the moving range of the motion axis avoids the risk of
improper mechanical operation or control. The PEL and MEL endpoint sensor signals are
connected to the PCI-M324 and servo drive at the same time, so that both the drive and the

control card can effectively stop the motion beyond the allowable moving range.

Pin | Mark | 1/O Description ‘ Pin ‘ Mark I/O Description

4 | MEL_1 | | [1%mechanical limitsignal(-) | 54 | MEL_3 | | 3“mechanical limit signal (-)
5  PEL 1 | 1% mechanical limitsignal (+) | 55 PEL_3 I | 3“ mechanical limit signal (+)
8 | MEL_2 | 2" mechanical limit signal (-) | 58 | MEL_4 I | 4™ mechanical limit signal (-)
9 | PEL_2 | 2" mechanical limit signal (+) | 59 | PEL_4 I | 4™ mechanical limit signal (+)

(1) Sink mode (NPN mode)

JP1 Sink

-

1 2 3
24V JP1

(2) Source mode (PNP mode)

JP1 source

-

Source

1 2 3

I
I
I
I
O
@
I
I
!
O
I
I
I
I
I
O
I
I
O
I
I
I
I
I
I
|
O
I
JP1 EGND }
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B ORG (axis control signal / DI signal)

Determine the starting position of the motion control: the mechanical action error and execution
order of the motion command will change the zero position of the servo drive and the starting

position of the mechanical device. Thus, for open-type control mechanical devices, you need to
execute homing after a certain motion distance or operation time to ensure the accuracy of the

motion control.

Pin Mark I/O Description ‘ Pin ‘ Mark I/0 Description
6 ORG_1 I 1* origin position signal 56 ORG_3 | 3" origin position signal
10 ORG_2 I 2" origin position signal | 60 ORG_4 | 4" origin position signal

(1) Sink mode (NPN mode)

JP1 Sink

-

1 2 3
24V JP1

JP1 source

-

Source

1 2 3
JPL EGND
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B SLD (axis control signal / DI signal)

Deceleration point signal control: when the motion-controlled object passes through the sensor
point, the motion speed reduces to the set deceleration motion control speed. When SLD control
mode is required, enable the SLD function first. For more information, please refer to the

PCI-M324 Programming Guide.

Pin | Mark | I/O Description ‘ Pin ‘ Mark | I/O Description
7 SLD_1 | | | 1% deceleration pointsignal = 57 @ SLD_3 I | 3" deceleration point signal
11 | SLD_ 2 | | | 2" deceleration pointsignal | 61 @ SLD 4 | | | 4" deceleration point signal

(1) Sink mode (NPN mode)

JP1 Sink

-

12 3
24V JP1

(2) Source mode (PNP mode)

JP1 source

-

Source

1 2 3
JP1 EGND

I
I
I
|
O
|
I
]
O
]
I
|
I
I
Q
I
|
O
I
I
|
I
|
|
|
I
I
'
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B DI (axis control signal / DI signal)

Digital signal input for axis control, which can connect to external digital signals to provide

reference signals to each PCI-M324 axis control.

Pin | Mark | 1/O Description ‘ Pin ‘ Mark | 1/0 Description
15 | DIL1 | | 1%axis GPIOinput 65  DI.3 | | 3%axis GPIO input
19 D2 I | 2" axis GPIO input 69  DI.4 | | 4™axis GPIO input

Note: GPIO is short for General Purpose Input / Output.

(1) Sink mode (NPN mode)

Power Supply

JP1 Sink

-

Internal Circuit

12 3
24V JP1

(2) Source mode (PNP mode)

JP1 source

-

1 2 3
JP1 EGND
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B EMG (global signal / DI signal)

Emergency stop signal input point: when the emergency stop is in action, the motion control
pulse output of each axis stops the output and enters the safety protection state. You can

operate all motion axes only when this signal is cleared.

Pin Mark I/O Description ‘ Pin ‘ Mark I/0 Description
3 EMG I Emergency stop signal 53 EMG | Emergency stop signal

(1) Sink mode (NPN mode)

Internal circuit
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B DO (axis control signal / DO signal)

Digital signal output for axis control, which can output digital signals to other peripheral devices.

The four main motion axes of PCI-M324 are built-in with the DO function.

Pin Mark I/O Description ‘ Pin ‘ Mark I/0 Description
24 DO _1 0 | 1®GPIO output 74 DO_3 o | 3“GPIO output
28 DO 2 O | 2"™GPIO output 78 DO 4 O | 4™GPIO output

Note: GPIO is short for General Purpose Input / Output.

(1) O.Cmode

————

I <10 mA

[e]
o
=)
=
=3
)
2

Internal circuit EGND
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B CMP (pulse output control / output signal)

Position comparison function: when the motion control position matches the program's position
comparison setting, the PCI-M324 generates a pulse signal. PCI-M324 has built-in functions for
two high-elastic CMP comparators: Channels #0 and #1. Please refer to Section 3.1.4 for

hardware interface details.

Pin Mark Description

1 3.3V CMP_OUT CMOS 3.3V triggering signal outputs when position reached
2 DGND CMOS 3.3V ground signal

3 DGND CMOS 3.3V ground signal

4 1.6(V) Vref LVDS reference voltage

(1) CMP signal circuit CMOS connection diagram

Internal circuit

(2) CMP signal circuit LVDS connection diagram

Internal circuit
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3.1.2 Servo drive DI/O interface
B ALM (axis control signal / DI signal)

Servo drive alarm: when the servo drive is in error, it issues an alarm to the PCI-M324 to notify

the control system that the current motion control cannot work properly.

Pin Mark I/O Description ‘ Pin ‘ Mark I/0 Description
14 | ALM_1 | | 1% servo alarm 64 | ALM_3 I 3"servoalarm
18 ALM_2 I 2" servo alarm 68 ALM_4 | 4" servo alarm

(1) Sink mode (NPN mode)

JP1 Sink

-

1 2 3
24V JP1

!—jﬁ Power supply
+24V

JP1 source

-

Source

1 2 3
JP1 EGND
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B SVON (axis control signal / DO signal)

The output of the Servo On signal enables or disables the operation of the current connecting

servo drive.
Pin Mark I/O Description ‘ Pin ‘ Mark I/0 Description
21 . SVON_.1 = O | 1%servoon 71 SVON.3 | O | 3“servoon
25  SVON 2 | O | 2"servoon 75 | SVON 4 | O | 4™servoon

(1) O.C mode

1 <10 mA

-

Internal circuit

3-10
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RDY (axis control signal / DI signal)

Servo drive ready signal input: the input of the ready signal notifies the users that the servo drive

is ready and can operate normally.

Pin Mark I/O Description ‘ Pin ‘ Mark I/0 Description
12 | RDY_1 | | | 1%servoready 62 = RDY_3 I | 3“servo ready
16 RDY_2 I 2" servo ready 66 RDY_4 | 4" servo ready

(1) Sink mode (NPN mode)

JP1 sink

-

1 2 3
24v JP1

(2) Source mode (PNP mode)

November, 2017

JP1 source

-

1 2 3
JP1 EGND

Source
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B NP (axis control signal / DI signal)

Servo in place notification function: notifies the users that the servo drive has reached the

specified target position.

Pin Mark I/O Description ‘ Pin ‘ Mark I/0 Description
13 | INP_1 | | 1% servo in place signal 63 | INP_3 I | 3%servoin place signal
17 INP_2 I 2" servo in place signal 67 INP_4 | 4" servo in place signal
(1) Sink mode (NPN mode)
JP1 sink
3.3V

—

1 2 3
24V JP1

18114

19]]01U0D

(2) Source mode (PNP mode)

JP1 source

-

1 2 3
JP1 EGND

3-12

Source
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B ALMC (axis control signal / DO signal)

Output signal for clearing the servo drive alarm.

Pin Mark I/O Description ‘ Pin ‘ Mark I/0 Description
23 | ALMC_1 | O | 1% alarm clearing signal 73 | ALMC_3 | O 3 alarm clearing signal
27 | ALMC_2 | O 2" alarm clearing signal 77 | ALMC_4 | O 4™ alarm clearing signal

(1) O.Cmode

Power supply

1 <10 mA

N P

Internal circuit EGNDl

November, 2017
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ERC (axis control signal / DO signal)

Error value clearing function: when the following conditions occur, PCI-M324 outputs an ERC

signal to the servo drive.

(1) PEL and MEL signals are triggered.

(2) EMG hardware circuit is triggered.

(3) Software EMG stop signal is triggered (API: _m324_emg_stop_erc).

(4) Force output ERC signal is triggered (APIl: _m324 set_erc_on).

(5) To follow the safety procedure, you must first clear the remaining command values in the

servo drive before starting the servo drive.

Pin Mark /0 Description ‘ Pin ‘ Mark 110 Description
st rd

22 ERC1 O 1" clear servo error 72 ERC.3 O 3" clear servo error
counter counter
nd th

26 ERC 2 O 2" clear servo error 76 ERC4 O 4" clear servo error
counter counter

(1) O.C mode

1 <10 mA

Internal circuit
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3.1.3 Servo drive pulse I/O interface
B OUT/DIR (pulse output control / DO signal)

Pulse output control function: PCI-M324 is built-in with six different pulse output control functions,
which are controlled by the DIR and OUT output interfaces. The hardware circuit is designed to
adopt the RS-422 differential line driver output interface, which can connect to RS-422

differential, optocoupler, and TTL unipolar interfaces.

Pin Mark I/O Description ‘ Pin ‘ Mark 1/0 Description

43 | DIR+_1 | O |1%direction pulse signal (+)| 93 | DIR+ 3 | O 3" direction pulse signal (+)
44 | DIR-_1 = O |1%direction pulse signal (-) | 94 | DIR-_3 = O | 3“direction pulse signal (-)
47 | DIR+_2 O |2™ direction pulse signal (+) 97 | DIR+ 4 | O | 4" direction pulse signal (+)
48 | DIR-_2 = O |2" direction pulse signal (-) 98 DIR- 4 | O | 4" direction pulse signal (-)
45 | OUT+ 1 | O |1%output pulse signal (+) 95 | OUT+ 3 O | 3“output pulse signal (+)
46 | OUT-1 O |1%output pulse signal (-) 96 | OUT- 3 O | 3“output pulse signal (-)
49 | OUT+ 2| O 2 output pulse signal (+) 99 | OUT+ 4 O 4" output pulse signal (+)
50 | OUT-_2 | O 2 output pulse signal (-) 100 | OUT- 4 | O 4" output pulse signal (-)

[ ] Differential mode

(1) Differential output connects to differential input

Internal circuit
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(2) Differential output connects to optocoupler

Internal circuit

(3) Differential output connects to single-ended input

|
Signal-! R

DDA _GN

Internal circuit

O— WA

9 7 1
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Encoder A phase, B phase, and Z phase feedback pulse input counter function: connects to the

position feedback from the servo drive or external linear scale.

Encoder A phase, B phase, and Z phase (axis control signal / DI signal)

Pin | Mark | 1/O Description ‘ Pin ‘ Mark | 1/O Description

29 | EA+ 1| | |1®Aphase encodersignal (+) | 79 | EA+ 3 | 3“Aphase encoder signal (+)
30 | EA- 1 | 1% Aphase encoder signal (-) 80 | EA-_3 I 39A phase encoder signal (-)
35  EA+ 2| | 2"A phase encoder signal (+) | 85 | EA+ 4 I 4™A phase encoder signal (+)
36 | EA- 2 I 2YA phase encoder signal (-) 86 | EA- 4 I 4"A phase encoder signal (-)
31 | EB+ 1| | 1% Bphase encoder signal (+) | 81 | EB+ 3 | 3B phase encoder signal (+)
32 | EB-_1 | 1% B phase encoder signal (-) 82 | EB-_3 | 3“B phase encoder signal (-)
37 | EB+ 2 | | 2"Bphase encodersignal (+) | 87 @ EB+ 4 | | |4"B phase encoder signal (+)
38 | EB-_2 | 2¥z phase encoder signal (-) 88 | EB- 4 | 4"B phase encoder signal (-)
33 | Ez+ 1 | 1% Z phase encoder signal (+) | 83 | EZ+ 3 | |39z phase encoder signal (+)
34 | EZ-_1 | 1™ Z phase encoder signal (-) 84 | EZ-_3 | 3% Z phase encoder signal (-)
39  EzZ+ 2 | |2vz phase encoder signal (+) | 89 | EZ+ 4 | 4"z phase encoder signal (+)
40 | EZ-_2 | |2" Z phase encoder signal (-) = 90 | EzZ- 4 | 4" Z phase encoder signal (-)

m  Differential mode

(1) Differential input mode

November, 2017
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3.1.4 Position comparison triggering signal output interface

PCI-M324 provides the position comparison triggering pulse output function, as shown in

Figure 3.1.4.1. In this example, the encoder feedback value of the servo motor is compared with
the P1 and P2 position set values. When the feedback value equals the P1 or P2 value, the
pulse signal outputs respectively to trigger the image acquisition card or CCD to take images.
The card provides two flexible high-speed comparator channels (Channels #0 and #1) for the
users to choose from. You can choose different pulse comparison sources and pulse output

interfaces according to the parameter settings to meet your application requirements.

e >
—>

P1l| Data ~ Interrupt signal (to host PC)
[ Comparator

L

Encoder feedback

Encoder Motor //

( Trigger Circuit )

Y

Figure 3.1.4.1 Position comparison triggering example
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B Channel #0 in-place comparator function description

The in-place comparator of Channel #0 has four sets of compare input sources for selection,
and they are the position counter values for axes #0, #1, #2, and #3. The output interface also
provides four sets of output interfaces for selection, and they are CMOS3.3V output, DO output
of each axis (24V), axis #3 RS422 DIR single serial output, and axis #3 RS422 dual serial output

at the same time (as shown in Figure 3.1.4.2).

Position counter

Select compare
source AXIS | AXIS | AXIS | AXIS

#0 #1 #2 #3

CMOS3.3V “ ’—‘ ’—‘ ’—‘ ’7

A
Output interface [ 15v-GND
selection
Axis DO output 24V
Channel #1 Comparator @:jZWﬁND
enable Uy U
D
Compare o1 RS-422 output
value set o
—» Axis #3 DIR
%Axis# DIRf
Pulse width selection T T RS-422 output
Pulse width setting Output selection Axis #3 OUT 1T
% Axis #3 OUT+
RS-422 Output
Note: in the output selection function interface, you can only select Axis#3 DIR 171
one channel for output. This means you cannot assign Channel #0 «k éxis#i DIR/
and Channel #1 at the same time for different signal output. o

Figure 3.1.4.2 Diagram of Channel #0 in-place comparator

CMOS 3.3V output interface: please refer to Section 3.1.1 for the mechanical DI/O interface

CMP signal description. Please do not share use with Channel #1.

DO output interface of each axis: please refer to Section 3.1.1 for the mechanical DI/O interface

DO signal description.

Axis #3 RS-422 DIR single serial output interface: please refer to Section 3.1.3 for the servo

drive I/O interface pulse output description.

Axis #3 RS-422 dual serial output interface: please refer to Section 3.1.3 for the servo drive I/O

interface pulse output description. Please do not share use with Channel #1.
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B Channel #1 in-place comparator function description

The in-place comparator of Channel #1 has four sets of compare input sources for selection,
and they are the position comparator values for axes #0, #1, #2, and #3. The output interface
also provides four sets of output interfaces for selection, and they are CMOS3.3V output,

DO output of each axis (24V), axis #3 RS-422 OUT single serial output, and axis #3 RS-422 dual

serial output at the same time (as shown in Figure 3.1.4.3).

Position counter

Select compare
source AXIS | AXIS | AXIS | AXIS
#0 #1 #2 #3

CMOS3.3V “ ’—‘ ’—‘ ’—‘ ’7

i

Output interface I T 15v.GND
selection
Axis DO output 24V
Channel #1 Comparator @:jZWﬁND
enable Uiy
—
Compare o1 RS-422 output
value set .
Axis #3 DIR
‘k Axis #3 DIR/
Pulse width selection T T RS-422 output
Pulse width setting Output selection Axis #3 OUT ]
% Axis #3 OUT-+
) . - RS-422 Output
Note: in the output selection function interface, you can only select .
one channel for output. This means you cannot assign Channel #0 Axis#3 DIR
and Channel #1 at the same time for different signal output. (Axis#3 DIR'/

Figure 3.1.4.3 Diagram of Channel #1 in-place comparator

CMOS 3.3V output interface: please refer to Section 3.1.1 for the mechanical DI/O interface

CMP signal description. Please do not share use with Channel #0.

DO output interface of each axis: please refer to Section 3.1.1 for the mechanical DI/O interface

DO signal description.

Axis #3 RS-422 OUT single serial output interface: please refer to Section 3.1.3 for the servo

drive I/O interface pulse output description.

Axis #3 RS-422 dual serial output interface: please refer to Section 3.1.3 for the servo drive I/O

interface pulse output description. Please do not share use with Channel #0.
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3.1.5 Position latch signal input interface

PCI-M324 provides the position latch function as shown in Figure 3.1.5.1. In this example,
when the measuring probe touches the workpiece surface, it triggers the DI signal to execute
the position latch function, which records the position counter value in the latch counter.

Then, by reading the latch counter value, you can see the position value when triggered.

g? Measurement
 J

| command |

Workpiece | Feedback |

Figure 3.1.5.1 Position latch function example

This card is designed with four sets of latch triggering source for selection. For details,

please refer to Figure 3.1.5.2.

Position counter

DI
r4d Al
24V_GND, N
Ez+ L I’H’ Latch
EZ- .
—»
ORG Pyl | Get latch data
Z
24V_GND L
MEL T
/ — .
Set latch logic
24V _GND F4an Select latch source T g

Figure 3.1.5.2 Position latch triggers source diagram

Axis DI, ORG, MEL input interfaces: please refer to Section 3.1.1 for the mechanical DI/O
interface DI, ORG, and MEL signals description.
EZ+ and EZ- input interfaces: please refer to Section 3.1.3 for the servo drive 1/O interface pulse

input description.
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PCI-M324 provides two types of terminal boards for you to choose from. They are
DB-100S general terminal board and DB-M324 adapter board with 25-pin D-SUB
connector and signal indicator. Please refer to the following sections for detailed

specifications and instructions.

4.1 DB-100S genera| terminal DoArd -« ccorrrmrm e 4-2
4.2 DB-M324 adapter board with signa| INAICALOr -+ v v rrrrrrrrerer e 4-3

4-1
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4.1 DB-100S general terminal board
B Specifications

(1) SCsI 100-pin 1.27 mm female connector
(2) Supports DIN rail mounting

(3) Dimension (L-157 x W-122 x H-45 mm)
(4) Pitch: 5.00 mm

(5) Wire diameter: 26 - 14 AWG

[ | DB-100S illustration

O
CN1

© | 76 100

7| PODOOHDOOOODOOOODOODODDODG|
DOPDDRROOODDDDDDBDOODDDD

26 CN3 50

DB-100S-01
1 CN2 25
DDDOODDODDDODDDDDDDDDDD @D

Y 00000000000000000000OOOD®
©| 5 75

%) ©)

Description of each DB-100S pin:

Mark Function
CNL SCSI 100-pin female connector (pin to pin)
Connector for the PCI-M324 servo motion control card and DB-100S
CN2 The terminal pins correspond to the CN1 pins
CN3 The terminal pins correspond to the CN1 pins

Note: the pin definition is the same as the CN1 on the PCI-M324 servo motion control card.

Please refer to Section 2.5.1.
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4.2

1)
(2)
®3)
(4)
(5)
(6)
(7)
(8)
(9)
(10)
(11)
(12)
(13)

(14)

November, 2017

DB-M324 adapter board with signal indicator
Specifications

SCSI 100-pin P1.27 mm female connector

D-SUB 25 P2.27 mm female connector

Supports DIN rail mounting

Dimension L-117 x W-215 x H-60 mm (PCB L-107 x W-209)

Pitch: 5.00 mm

Operating temperature: 0°C - 60°C (32°C - 140°F)

Emergency stop input: EMG

Mechanical I/O interface signal input: PEL x4, MEL x4, ORG x4, SLD x4

Servo drive interface signal output: ALM x4, ALMC x4, RDY x4, SVON x4, INP x4, ERC x4
GPIO point: DI x4, DO x4

Power supply input: +24 Vpc £ 10%; power consumption: 3W typical

For DDA pulse level voltage output: +5 Vpc (output from PCI-M324), | < 100 mA
Indicator light: power indicator, emergency stop input indicator, mechanical I/O interface
signal indicator, servo drive interface signal output indicator, GPIO indicator

DB-M324 is for NPN wiring type
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[ | DB-M324 illustration

I CN1 56666668 666666686 u o
© _ - CN9 CN6 @ j@l
===
m SEEEEEIEIS SEEEEEEE
CN7 CN8 o
o
@ @ @ @ o o o o o o
5 5 5 5 o o o o o o
g : : : g : 2 : o o o o o o
: 3 : 2 Z 2 2 o o o o o o a
o5 °5 o5 wfl &« & & = = =
: o 2 ° 2 . g = o o o o a a
o : o : o : o : = o = o = =
© o o S : 2 S o . 2 o o o a o a
(=== )/ N
9 o] (©) (© ©
0 CN2 CN3 CN4 CN5
Description of each DB-M324 pin:
Mark Connector type Function
. Connector for the PCI-M324 servo motion control
CN1 SCSI 100-pin female connector card and DB-M324
CN2 D-SUB 25 female connector Axis 1 motor connector
CN3 D-SUB 25 female connector AXis 2 motor connector
CN4 D-SUB 25 female connector Axis 3 motor connector
CN5 D-SUB 25 female connector Axis 4 motor connector
CN6 Plug-in terminal block connector | 24V power input connector
CN7 Screw terminal block connector Axis 1, 2 motor connector for other signals
CN8 Screw terminal block port Axis 3, 4 motor connector for other signals
CN9 Plug-in terminal block connector DDA 5V voltage output
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B DB-M324 CNL1 pin definition diagram

O] q - 1[g g5
=1 -

N

\/V L

=

iel a 50LE B100

(2) (1)

Note: the pin definition is the same as the CN1 on the PCI-M324 servo motion control card.

Please refer to Section 2.5.1.
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B DB-M324 CN2/CN3/CN4/CN5 (Axis 1 - Axis 4) pin definition diagram
=7
— [© ] q -
- ] 25/m 0"
5 e 0 g
s s 2" O0pg
s A ¥ 0g
a 2" : D O
s 2 : ° 0 o
° : o ° ] 1]
° J D u
0o
0 0pg
X
- — 140 g |4
(2) (1)
Description of each DB-M324 CN2 / CN3/ CN4 / CN5 pin:
Pin | Mark | 1/O Description ’ Pin ’ Mark | 1/0 Description
1 OUT- O | Output pulse signal (-) 14 DIR- O | Direction pulse signal (-)
2 OUT+ | O | Output pulse signal (+) 15 DIR+ O | Direction pulse signal (+)
DDA DDA 5V voltage output, . .
3 5V | <100 mA 16 INP | Servo in place signal
4 EGND G | 24V ground signal 17 | peL | 1 | Mechanical positive limit
signal
5  MEL | | Z'gﬁgf‘”'ca' negative limit ' 45 | o4y | v | +24V power supply
6 | SVON | O | Servoon 19 ALM | Servo alarm
7 | EGND | G | 24V ground signal 20 | EGND | G | 24V ground signal
8 | EGND | G | 24V ground signal 21 | EGND | G | 24V ground signal
9 | ALMC | O | Servo alarm clearing output | 22 ERC Clear servo error counter
10 EZ+ I Z phase encoder signal (+) 23 EZ- | Z phase encoder signal (-)
11 EA+ I A phase encoder signal (+) | 24 EA- | A phase encoder signal (-)
12 EB+ I B phase encoder signal (+) | 25 EB- | B phase encoder signal (-)
13 FG G | FG

Note: CN2 - CN5 correspond to the CN1 Axis 1 - Axis 4 control points respectively on the PCI-M324 servo

motion control card. Please refer to Section 2.5.1.
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Terminal Board

B DB-M324 CN6 pin definition diagram

3 1

@I UL

Description of each DB-M324 CNG6 pin:

‘\‘ -

Pin Mark Description
1 FG FG
2 EGND 24V ground signal
3 24V Power +24V

November, 2017
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B DB-M324 CN7/ CNB8 (Axis 1, 2) pin definition diagram

16141210 8 6

4 2

%% %% % %

%%

odeloPRRe

\

1 1 1
15131197531/

Description of each DB-M324 CN7 / CN8 pin:

(- —

Pin Mark I/O Description ’ Pin ’ Mark 1/0 Description
ORG | | 1* origin position signal 9 DO O | 1*GPIO output
ORG | | 2" origin position signal | 10 DO O | 2" GPIO output
st . . st R .
3 SLD | 1 deceleration point 11 MEL | 1 _me_chanlcal negative
signal limit signal
nd . . nd . .
4 SLD | 2 deceleration point 12 MEL | 2 _mt_echanlcal negative
signal limit signal
st . .
5 | RDY | | 1%servoready 13 | PEL | | 1" mechanical positive
limit signal
nd H P
6 RDY | | 2" servo ready 14 PEL | 2 mechanical positive
limit signal
DI I 1*' GPIO input 15 EMG | Emergency stop input
DI | | 2""GPIO input 16 = EGND | G | 24V ground signal
Note:

1. GPIO is short for General Purpose Input / Output. The EMG of CN7 / CN8 is the same signal pin.

2. CN7 and CNB8 correspond to the CN1 Axis 1 - Axis 4 control points respectively on the PCI-M324 servo

motion control card. Please refer to Section 2.5.1.

4-8
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Terminal Board

B DB-M324 CN9 pin definition diagram

Description of each DB-M324 CN9 pin:

Pin Mark Description
1 5VGND DDA 5V ground signal
2 DDA5V DDA 5V voltage output

Note: CN9: The DDA 5V voltage output source is from the PCI-M324 control card, | <100 mA.

Limited to use as a reference point for 5V voltage comparison.

November, 2017
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Description of the DB-M324 LED

Power LED

| LED Array

Item Description
Power LED 24V power input indicator light
LED Arra The function definition of the LED signal indicator light is the same as the CN1
y on the PCI-M324 servo motion control card. Please refer to Section 2.5.1.
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This chapter lists the standard wiring diagrams for the PCI-M324 motion control card

connected to various series of servo drives.

5.1 Terminal board Wiring examp|e ............................................................. 5-2
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5.1 Terminal board wiring example

B Delta ASDA-A2 series servo drive

PCI-M324 CN1 Delta ASDA-A2
45 OUT+_1 HPulse 38
46 OUT-_1 /HPulse 29
43 DIR+_1 HSIGN 46
44 DIR-_1 /HSIGN 40
29 EA+_1 OA 21
30 EA- 1 OA- 22
31 EB+_1 OB 25
32 EB-_1 OB- 23
33 EZ+_1 Oz+ 50
34 EZ-_1 oz- 24
22 ERC_1 CCLR 10
12 RDY_1 SRDY+ 7
14 ALM_1 SRDY- 6
13 INP_1 ALRM+ 28
21 SVON_1 ALRM- 27
23 RALM_1 TPOS+ 1
5 PEL_1 TPOS- 26
4 MEL_1 SON 9
7 SLD_1 ARST 33
6 ORG_1 NL(CWL) 32
PL(CCWL, 31
2,20 EGND
52,70 EGND Break Coil
EMGS 30
533| EMG —?3—4 COM- | 45.47.49
GND 12,13
GND 44
1 E_24V COM+ 11
51 E_24V
© +g:1/V %
(e, O

Table
E== = 7 7 J::h Motor :|

© orG @) siLp2 ’_@_‘
MEL
PEL SLD1
3

PCI-M324 Axis 1 connected to Delta ASDA-A2 series servo drive
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B Delta ASDA-B2 series servo drive

PCI-M324 CN1 Delta ASDA-B2
45 OUT+_1 HPulse 38
46 OUT-_1 /HPulse 36
43 DIR+_1 HSIGN 42
44 DIR-_1 /HSIGN 40
29 EA+_1 OA 21
30 EA- 1 OA- 22
31 EB+_1 OB 25
32 EB-_1 OB- 23
33 EZ+_1 oz+ 13
34 EZ-_1 oz- 24
22 ERC_1 CCLR 10
12 RDY_1 SRDY+ 7
14 ALM_1 SRDY- 6
13 INP_1 ALRM+ 28
21 SVON_1 ALRM- 27
23 RALM_1 TPOS+ 1

5 PEL_1 TPOS- 26
4 MEL_1 SON 9
7 SLD_1 ARST 33
6 ORG_1 NL(CWL) 32
PL(CCWL) 31
2,20 EGND
52,70 EGND
EMGS 30
53,3 EMG —?3—4 COM- | 454749
GND 12,13
GND 44
1 E_24V COM+ 11
51 E_24V
o +g:1/V
O
Table
d ra i L] Motor :|

&PEL SLD1

?%E ORG ) sLD2 ’_@_‘ MEL
L1

November, 2017

PCI-M324 Axis 1 connected to Delta ASDA-B2 series servo drive
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B Delta ASDA-A3 series servo drive

PCI-M324 CN1 Delta ASDA-A3
45 OUT+_1 Pulse 43
46 OUT-_1 /Pulse 41
43 DIR+_1 SIGN 36
44 DIR-_1 /SIGN 37
29 EA+_1 OA 21
30 EA- 1 OA- 22
31 EB+ 1 OB 25
32 EB-_1 OB- 23
33 EZ+_1 oz+ 50
34 EZ-_1 0z- 24
22 ERC_1 CCLR 10
12 RDY_1 SRDY+ 7
14 ALM_1 SRDY- 6
13 INP_1 ALRM+ 28
21 SVON_1 ALRM- 27
23 [ RALM_1 TPOS+ 1
5 PEL_1 TPOS- 26
4 MEL_1 SON 9
7 SLD_1 ARST 33
6 ORG_1 NL(CWL) 32

PL(CCWL) 31
2,20 EGND
52,70 EGND
EMGS 30
533| EMG _TFI—\D_‘ Com- | 4547.49
GND 13,19
GND 44
1 E_24V COM+ 11
51 E_24V
1o o
O O
Table
o Z Z Z J::IE Motor :|
PEL SLD1 I%ORG SLD2 ’—@—‘ MEL
[~

PCI-M324 Axis 1 connected to Delta ASDA-A3 series servo drive
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B Panasonic Minas A series servo drive

MINAS-CN I/F
PCI-M324 CN1 (Panasonic)
45 | OUT+_1 PULST | 3
46 | OUT-_1 PULS2 | 4
43 | DIR+_1 SIGNT_| 5
44 | DIR-_1 SIGN2_| 6
20 | EA+1 OA+ | 21
30 | EA-1 OA- |22
31 | EB+1 OB+ |48
32 | EB-1 OB- |49
33 | Ez+_1 oz+ |23
3 | Ez1 0z- |24
22 | ERC_1 cL_ |30
12 | RDY_1 S-RDY+ | 35
14 | ALM_1 S-RDY- | 34
13 | INP_1 ALM+ | 37
21 | SVON_1 ALM-_ | 36
23 | RALM_1 COIN+_| 39
5 | PEL1 COIN- |38
4 | MEL1 SVR-ON | 29
7 | sb_i ACLR | 31
6 | ORG_T cwL [ 8
cowL | 9
220 | EGND —O BRKOFF+]| 11
52,70] EGND Break Coil BRKOFF- | 10
533| EMG_ |o [ o com-_[ 41
GND_ | 13
GND_ | 25
1 | _E 24V com+ | 7
51 | E 24V
s o
o o

Table
= = = = DE Motor :|

%PEL SLD1 I%ORG SLD2 ’—@—‘ MEL

PCI-M324 Axis 1 connected to Panasonic Minas A series servo drive
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B Mitsubishi J2S series servo drive

PCI-M324 CN1
45 OUT+_1
46 OUT-_1
43 DIR+_1
44 DIR-_1
29 EA+_1
30 EA-_1
31 EB+_1
32 EB-_1
33 EZ+_1
34 EZ-_1
22 ERC_1
12 RDY_1
14 ALM_1
13 INP_1
21 SVON_1
23 RALM_1

5 PEL_1
4 MEL_1
7 SLD_1
6 ORG_1
2,20 EGND
52,70 EGND
53,3 EMG
1 E_24V
51 E_24V

oV

J2S-CN 1A
PP 3

PG 13

NP 2

NG 12

LA 6

LAR 16

LB 7

LBR 17

Lz 5

LZR 15

CR 8

RD 19

INP 18

—1 sGov) | 10
L | sG(ov) | 20
COM(+24V)| 9

J2S-CN1B
ALM 18
SON 5
RES 14
LSP 16
LSN 17
— sG 10
| sG 20
COM(+24V)| 13

+24V

Table

il

DE Motor :l

yal
|@_|PEL
L]

SLD1

I orG (@) sip2

LS)hyvey

PCI-M324 Axis 1 connected to Mitsubishi J2S series servo drive
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B Yaskawa SGDM Sigma Il series servo drive

+24V OV
o 0
PCI-M324 CN1 SGDM-CN1
45] OUT+_1 PULS |7
46 [ ouT-_1 *PULS
47 DIR+_1 SIGN [ 11
48| DIR-_1 *SIGN_ [ 12
29| EA+_1 PAO_ [33
30| EA-_1 *PAO | 34
31 EB+_1 PBO_ [35
32| EB-_1 *PBO_ [ 36
33| Ez+.1 PCO |19
34| EzZ_1 - *PCO_ [ 20
22| ERC_1 | Rk CLR [15
12| RDY_1 | *CLR | 14
14 ALM_1 /S-RDY+ | 29
13] INP_1 /S-RDY- | 30
21 SVON_1 ALM+ [ 31
23[ RALM_1 ALM- |32
4| PEL_1 ICOIN+ | 25
5 | MEL_1 /COIN-_| 26
6| SLD_1 /SVR-ON | 40
7 | ORG_1 /ALM-RST | 44
P-OT |42
2 | EGND N-OT |43
20| EGND Oseacan TGON+ | 27
/TGON-_| 28

2| E_2av
52| E_24V +24V-IN_| 47

T °

o 0

Table
= v = = T = = e /I,I:h Motor :l

l_@_lPEL SLD1 rl%?RG SLD?—@— MEL
—

PCI-M324 Axis 1 connected to Yaskawa SGDM Sigma Il series servo drive
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EzDMC Functions

November, 2017

EzDMC is a serial control tool to test the functionality of the serial connection. When
EzDMC is operating, the system monitors and automatically categorizes the connected
PCI-M324 motion control cards. You may use the listed cards to determine if the cards
are functioning properly and select each card for functional testing. The following

introduces how to operate the functions of EzDMC.

6.1 INtroducCtion t0 EZDMGC fUNCLIOMNS ««++« v xrrrrrrrmrenmtitiiiietiiiiiieieieieiaeaeanas 6-2
6.2 Operate M324 functions With EZDIMC -+ ++-eeeeeeeeeeaiiiaiiiieieeeeee 6-3
6.3 FING PCI-MB24 CAIQ -+ vevverrrermenaititii ettt ae s 6-3
6.4  4-axiS MOLON FUNCHION CONLIOL -+ rxrrmrrrtitii it 6-4
6.5 Function description of File and SIMUIAtION:----«+-eeeeeeeeerraaniiiiia 6-7
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6.1

Introduction to EzDMC functions

As shown in Figure 6.1.1, once you launch EzDMC, the program screen as shown below

appears on your computer system. Please refer to the following table for the functions of

each block.

Figure 6.1.1

No. Function
Q) Function menu.
() Tool bar for basic operating functions.
3) Area for displaying the main controller system and expansion module list.
4) Area for dis_playing the basig messages of expapsion functio_ns and (_)pera_tion control.

It operates in SDI mode which can display multiple relevant information dialog box.
©) Program status display area: area for displaying the connection status of the system (for

the DMC motion card).

November, 2017



PCI-M324 User Guide EzDMC Functions

6.2 Operate M324 functions with EzDMC

When the PCI-M324 card and connection modules (e.g. drive and motor) are set up,

please follow the procedures below to use EzDMC to test the connection:

1. Open EzDMC. 6
2. Find the PCI-M324 master card. (Refer to Section 6.3.)

3. Open the motion control screen.

4. Set the pulse output / input mode and 1/O related settings. After making sure the settings are

correct, you can start the motion control.

6.3 Find PCI-M324 card

To find the PCI-M324 card, click Initial in the tool bar to scan the system as shown in Figure 6.3.1.
This defines the amount and configuration status of all PCI cards in the current host system.
When the search is complete, the device list displays the status of all found cards as well as the

amount and configuration of the master cards.

File(F) HardWare(H) Option(Q) Simulation(S) About

Slave Hardware

8 M324 CardiD 1

Figure 6.3.1
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6.4 4-axis motion function control

After finding the M324 cards, select the card for operation (as shown in Figure 6.4.1),

and the operation screen for the 4-axis motion module is displayed (Figure 6.4.2).

b
Slave Hardware
M8 1324 CardD 1 i
S ——— J
Figure 6.4.1
- =
i Interiace\:v‘D Pulse /0 J Interrupt I;-IlsTA-kls- ----------- -\I D_DelateSetting
= ‘I ¢P-I--’.VIC lI Configuration Configuration . : m ﬁ : Distance lin Pulse
aA::EI Adisl Awis2 A3 i Aais 0 Auis 1 Ais 2 Autis 3 ‘I 1 : Fost v 0 Fuse
RDY Jl Command Fosiion: [0 ] [0 [0 [ 1 j Pes1Z 0 Pulse
e : : : z :: FeedBack Position: [0 [ [0 [0 H i Selsct-—— E : o2 [0 Puse
aiL . . . . |= Positior Errar: [0 jo [0 [0 H 2 [ 0 Puse
= Target Pasition: [0 |0 [0 [0 |\ [Select b~ [ G Fuke
. . . . Velocity: [0 o o o} |[Tmmmmm————— o Toos
v @ @ Motion Status : [0 [0 [ [ | Opercte Mode =
DIR . . Positon | Position | Positon | Position J': & Linel " Hel o [ IFidkss
MG . . T____s___ Reset Reset Reset Reset VI Depth ,70 Pulse
N N ] enupt Stalus T 0 Aris 1 Avis 2 s 3  Lined Continus pich 0 Fuke
ERC . . Event Intemupt (HEX] [0 [a [0 [ e Al Statvel [T g PPS
£z . . Interupt Count =[0 [0 [o [o o [TETATS P e— -~
By . . Clear ‘ Clear | Clear | A3 End ' (10)
Lic ————— ——— Thoo
o0 : : Operate Maving Il : TDec
v @ @ c | e | | Mode ! 1 Mg Mods
SYON : Offsetvalue [ 1 | (e [ 5 Eog
. . (5) 1 1~ A Move eference
RALM , ’ - | |\ ,I @ Command (" Encoder
e S T BNt e ] i -
Figure 6.4.2
No. Item Description
1) /O Status Display the current status of the M324 card using the ON /
OFF status signal.
Interface I/0O Configuration Interface /O Configuration: I/O setting interface.
(2 Pulse I/O Configuration Pulse 1/0O Configuration: pulse setting interface.
Interrupt Configuration Interrupt Configuration: interrupt setting interface.
- . Display each count value of the motion status, includin
3 Position / Velocit
Yy command, position, speed, motion status, etc.
) Interrupt Status Display the events and number of times that interrupt
occurred.
(5) Operate Moving Motion control buttons.
(6) First / Second / Third Axis Select the motion control axis.
Set the motion operation mode, including point to point,
@) Operate Mode . P : 9p P
homing, constant velocity, etc.
When executing homing, you need to set the parameters,
(8) Home_setting homing mode, and the offset value when homing is
complete.
Set the motion commands, including motion distance,
9) Operate Setting starting velocity, maximum velocity, and acceleration /

deceleration time.
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No. Item Description

B Check [Repeat] to repeatedly execute clockwise and
counterclockwise motions.

B Check [S Curve] to set S-Curve acceleration /

(10) Moving Mode deceleration; otherwise, T-Curve is used.
B Check [Abs] to use absolute motion; otherwise, relative
motion is used.
Command: absolute motion follows the command counter.
(11) A Move Reference Encoder: absolute motion follows the feedback counter

position.

After opening the main screen, you need to set the relevant settings before executing motion

control.

B Openthe l/O related setting screen to set the signal logic, including ALM, INP, ELL, ORG, etc.

Click Interface 1/0 Configuration (Figure 6.4.3) on the M324 main screen to open the 1/0

related setting screen (Figure 6.4.4).

Pulze 140 [Rterrupt
Configuration Configuration
Figure 6.4.3
E3+ PCI- M324 Card Mo: 1Interface [/Q Configuration @
Servo Motor Signal
ALM INP Servo 10
Logic Response Mode Logic Enable/Dizable SYON - RALM
% fctive Low &+ Stop immediately (% Active Low {* Dizahle INP . .
7 Active High " Dec. to Stop (™ Active High " Enable INF
ERC DIO
Active Timing DD ]|
(¢ NULL " 128us (" 148us  © 188us ERC Dut .
" B8us  42Bus € V4Buz O 1.38m: .

Mech Signal

ELL ORG EZ LTC
Logic Logic Logic Loaic
i Active Low & Active Low & Active Low f+ Rizing edge
" Active High € Active High " Active High " Falling edge

Src

SD 0l
EnablefDizable| — Logic Response Mode ~ EZ

% Dizable 50 v Active Law || Slow Down Then Stop ~ ORG

" Enable 5D ™ Active High || © Slow Down Only - MEL

Figure 6.4.4
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B Open the pulse I/O mode setting screen to set the relevant settings, i.e. AB Phase,
CW/CCW, PLS/DIR, then you can execute motion control.

Click Pulse I/0 Configuration (Figure 6.4.5) on the M324 main screen to open the pulse
I/0O mode setting screen (Figure 6.4.6).

Mnterface 10 Pulze 1/0 Interrupt
Confiquration |l Configuration Configuration

Figure 6.4.5 Function buttons

E3+ PCI- M324 Card MNo: 1 Pulse [/O Configuration @

iz 0 MNewt =

Pulse Output Mode
Pulse Mode

ol L T =t
i.....obthizcand....

<= Previous

e OUT/DIR - OUT is falling edge.
DIR+ ig high lewel

OUT/DIR - OUT is falling edge,

QUT/DIR - OUT iz niging edge,
DIR+ ig high level

QUT/DIR - OUT iz rising edge,

DIR+ iz low level DIR+ iz low lewel

" CwW/COW Faling edge 7 Ow//COW Rising edoe

(" AB Phase & (" AB Phaze B

Pulse Width Gear
102.40kHz numeratar (4

i, | Fastiode B [

Ptilse Input (Feedback Counter)

Source Logic
{* Encoder [External | " Pulze Output (Interal) * Do Nat Inverse Direction
Move Ratio [Feedback/Command) = |0 " lrwverse the Direction

Mode
(% 1% A/ Phase  2{A/B Phase " 4% A/B Phase

Figure 6.4.6 Pulse 1/0 mode setting
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6.5 Function description of File and Simulation

1. Function to load / save configuration file

When you have completed the motion control, you can save the M324 motion control parameters
by using [File] > [Save Configuration_M324] in the function menu. When you open EzDMC the
next time, you can use [File] > [Load Configuration_M324] in the function menu to load the set
motion control parameters to EzDMC, and execute the motion control of this configuration.
Please refer to Figure 6.5.1 for the function menu as described above.

[Fikﬂ] HardWare(H) Option(Q) Simulation(S)

Sawve Configuration_DMC(S)

Load Configuration_DRC(L)

Load Default Configuration_DMC(D)

i Load Configuration_h324
i Load Default Configuration_h324
A Y

- ———

-

Figure 6.5.1 Function to load / save configuration file

2. Interrupt Configuration function page

Click Interrupt Configuration (Figure 6.5.2) on the M324 main screen to operate the interrupt
function. Once you click this button, the [Interrupt Configuration] setting screen (Figure 6.5.3)
pops up. Check the conditions for interruption and when the conditions are met, interruption
occurs and enters the callback function, and the [Interrupt Status] screen shows the number of

times that interruption occurred (Figure 6.5.4).

{ Inkerface [0 Pulze 120 [ Irberrupt
{ onfiquration Configuration |} Configuration

Figure 6.5.2 Function buttons

£3« PCI- M324 Card Mo: 1 Interrupt Configuration @

iz JAwis 1 |JAwis 2 [Awis 3

Nomal Stop r |— |— [ Cleardll | Selectal |
Mext Command Continued | [ [ [ Clear Al | Seleu:t.ﬂ'-.ll|
Acceleration End r I r ™ Cleardll | Selectal |
D eceleration Start I [ [ [ Clear All | Seleu:t.i'-.ll|
Hame Mads Firish r r r ™ Cearél | Selectal |

Selectall| Select &l| Select 4| Select 41

Figure 6.5.3 Interrupt Configuration setting page
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Interrupt Status — f======== 3
o AdisO 1 AdisT Auiz 2 Az 3
Exvent Interupt [HE3) H | |
Interrupt Count =:| :| | |
1 1
Clear ‘ E Clear | Clear | Clear |
I

LT T

Figure 6.5.4 Number of times that interruption occurred

3. Speed / position curve page

You can open the speed and position simulation screen by clicking [Simulation] >
[Drawspeed_M324] and [DrawsPos_M324] in the function menu. As shown in Figure 6.5.6 and
Figure 6.5.7, these are the simulation images for the helical motion speed and position. After you
select the [CardNo] and [Axig], click Start, and the motion image is displayed when the motion

control card starts the movement.

Simulation(3) | About

Figure 6.5.5 Speed / position curve selection function

ol PCI-M324_Position_Curve

Config
A |A:-:isNoD j ' Az |AxisNo‘I j Z Auiz |A:-:isN02 j PicRadio (5000 »| Pulze/Block

Cardha

CardMo:0

Input
¢ Cmd ¢ Pos

Config
Fic: Auis
1 Axis
™ 2 Axis
(% 3Axis
Colar

Red hd

Fegulate

Ongin
3D v-Fotate
45 -

— ¥ Coor l—

Figure 6.5.6 Position simulation image
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ok PCI-M324_Speed Curve
Config

Az peieial w | | AR [AiNg] - Zhis: [puisMa? - PieRadio [ 2npon ~| PP5/Block

CardMo Choice Axiz
Card Mo (> | | i ¥ s Z Auis

Start

Clear all

Figure 6.5.7 Speed simulation image

4. CMP setting screen

You can open the CMP setting screen (Figure 6.5.9) by clicking [Option] > [M324_Compare]

in the function menu. To output the trigger signal when in motion, set the CMP start position,
end position, and interval.

Option(Q) | Simulation(5) About

AT

AZF Capture Compare

J Lompare bus

B A 0 b s
LI Lompar

[11]

1
iM324_Compare i
L ]

P ———

Figure 6.5.8 Open the position comparison setting screen
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B PCI-M324 CMP @
CardMa: Card Ma: 1
Compare Channel Eumpalre Source u:‘lp;;‘\?g::;ts e
fo Amiz0 . (+ 1.26us
= Channel 0 F fis 1 ™ Source Axiz DO 24 7 Eds
T r Ais 7 ™ Awiz 4 DIR or PLS[RS422) ~ 2.92us
. i |
£ fis 3 Auxiz 4 DIRY PLS[RS422) ~ Elus ’D—
n] k
perate Dizable

Compare
Count

0
bk
Start | Interval | End ] R
<ecSet Position Pozition Set>>> | TGP

Figure 6.5.9 Position comparison function setting screen
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